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OpenRoads Survey: Data Processing 
Process Overview 

This document will provide an overview of the steps to process and edit topo survey data in OpenRoads 

Designer. 

ODOT Feature Definitions 

Feature definitions are used to control symbology, annotation, and various other properties that are 
applied to the geometric elements as the survey information is processed. 
 
A feature definition is assigned to each survey point as the data is collected in the field. The ODOT Standard 
field code list is available in Adobe PDF format in the OHDOT CADD folder listed below: 
 

…\OHDOT\Standards\Survey Files\Field Codes\ 
 
The feature definitions are used by the software for the following: 
 

• Define what the surveyed information represents such as curb, centerline, edge of pavement, a 
mailbox, etc. 

• Control symbology in various views, including capability to define differing symbology in plan, 
profile, and 3D spaces 

• Define terrain modeling attributes (spot, break line, void, etc.) for each surveyed point or linear 
feature 

• Define the display characteristics of terrain models 
 
The feature definitions are defined in the following DGN Library: 
 

…\OHDOT\Standards\Dgnlib\Feature Definitions\OHDOT_Feature_Definitions.dgnlib 
 

Point Features 
When survey data is processed, each field shot is stored as a Point Feature in the current Field Book 

within the active model of the active design file. For example, the field code “PP” is used to designate a 

power pole. When the survey data is processed, the power pole code is plotted in MicroStation using an 

ODOT standard cell element as shown below: 

 
Note: OpenRoads Designer does not place any annotation with the survey information. Annotations are 

added using the Survey Decorations or Element Annotation commands. 
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Point Names 
Each survey point in the Field Book must have a unique point name. Point names are assigned in the field 

by the surveyor as the data is collected. There are no specific point name restrictions for OpenRoads 

Designer Survey processing other than ensuring that each point name is unique. 

 

Section 306.2 of the ODOT CADD Engineering Standards Manual details standard GEOPAK COGO 

Element names for field collected data. 

 
• Survey shots are to be given the two-character prefix “SV” followed by a numeric value. For example: 

SV1000, SV1001, SV1002, etc. 
 

• Monumentation shots can be given the two-character prefix “MN” followed by a numeric value. 
 
Care should be taken to avoid the use of duplicate point names when collecting data in the field. The 

OpenRoads Survey product provides options for editing duplicate point names if duplicates are 

encountered during the import process. See Chapter 8 for more information on duplicate point names. 

 

Linear Features 
A series of points representing curvilinear features can be connected as a Linear Feature. 
 
Linking Codes, which are special characters that are entered after the feature name as the data is 

collected, are used to define the linear features. The following liking codes are configured for ODOT use: 

BL* - Begin Line 
EL* - End Line 
OC* - Point on Curve (begin/end non-tangent curve) 
CL* - Close 
 

Important Note! 
This is a change from previous older versions of the legacy ODOTcadd Standards. 
 
Previously, the linking code was included after the feature code. In the October 16, 2016 release 
of the ODOTcadd Standards, the default value for the linking code location was been changed to 
specify that the linking code is included after the feature name. This change has been made to 
facilitate drawing the linework on the data collector and in Trimble software. 
 
All field data collected after the October 16, 2016 update shall be collected with the linking 
code listed after the field code. 
 
When processing old datasets with the OpenRoads Designer Survey tools, it is necessary to 
reconfigure the Survey Settings for an individual Field Book design file to specify the location of 
the linking code before the feature code. Instructions on how to make this change are presented 
later in this chapter. 
 

 
The mapping codes can also be entered as numeric values. The numeric values are defined in the OHDOT 

Workspace as shown below: 



 
Ohio Department of Transportation 
Office of CADD and Mapping Services 

January 2021 

 

OpenRoads Survey: Data Processing 300-3 

 

1 = BL* 
2 = EL* 
3 = OC* 
4 = CL* 

 
To collect a series of 3 points representing a fence line; each point would be coded as follows in the field: 

FEN BL* 
FEN 
FEN EL* 
 

If you elect to use the substitution linking codes, the fence line would be coded as follows: 

FEN 1 
FEN  
FEN 2 
 

Linear Features are named according to the feature code name used to collect the shots that define the 

chain. In the above example, a Linear Feature named “FEN” will be created in the field book. If a second 

fence line is collected, the software will increment the name by 1. For example, a second fence line would 

be named “FEN_1”. Subsequent fence lines would be incremented by 1. 

 

Field Attributes 
Many of the ODOT field codes allow for the use of attributes to store additional information with a specific 
survey shot. For example, the feature code “PP”, used to specify a Power Pole, has the following attributes: 
 

Material 
Owner 
Pole# 

 
These attributes are used to build custom annotations that are placed in the file using the Element 
Annotation commands. 
 
See the ODOT Code list for a summary of feature codes and the associated attributes. 
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Dual Coded Points 
Combining two unique feature codes and line descriptions within a single point description is supported. 

For example, a single field shot could be coded as follows to begin two separate linear features: 

EP BL* DR BL* 

The above example specifies the beginning of an edge of pavement line (EP BL*) and the beginning of a 

driveway line (DR BL*). 

Since each survey point can only have one field code, two separate points must be stored for dual coded 

survey shots. Point SV2112 is stored at the location of the shot with the field code EP. An additional point is 

stored at the same location with the field code DR. The additional point is named with the same point name 

that was present in the data and appended with “_1”.  In the example above two points will be stored in the 

Field Book named “SV2112” and “SV2112_1”.  This allows the double coded shots to represent two features 

with different feature codes. 

Caution: When dual coding points using feature definitions that include attributes, be aware that the 

software does not know which attribute goes with which point. Both points will be assigned all the 

attributes. 
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Annotation Scale 

MicroStation’s annotation scale is used to control the display of the following items: 

• Text 

• Dimensions 

• Detailing Symbols 

• Cells 

• Custom Line Styles 

Cells, text, and custom line styles placed by OpenRoads Designer survey processing are drawn according to 

the current MicroStation annotation scale value. 

Think of the annotation scale as a multiplier. The original size of the element is multiplied by the current 

annotation scale value to determine the display size of the element. 

The cells and custom line styles defined in ODOT’s CADD Standards are defined in one of two ways:  

• “Cosmetic” cells and linestyles are used to represent the location of an item, but not the actual size 

of the item. These items are placed in the design file using a scale of 1.0.  The display of cosmetic 

cells and linestyles is scaled automatically by ORD using the active Model Annotation Scale value. 

o A mailbox is an example of a cosmetic cell that is used to designate the location of the item, 

but not the actual size of the item. 

o A fence line is an example of a cosmetic linestyle. The location of the “x” on the fence line is 

used as a symbolic representation of the line type and does not represent specific post 

spacing for the fence line. 

o These cells and linestyles will change size when the MicroStation Annotation Scale is 

changed. 

 

• “Physical” cells and linestyles are used to represent both the location and the size of an item. These 

items have been drawn at their actual physical dimensions and are placed in the design file, by the 

user, at a scale of 1.0. 

o A pavement marking right-turn arrow is an example of a physical cell which is always 

placed at its actual size. 

o A pavement marking line, such as a lane line, is an example of a physical line style that is 
always placed using the actual dash and gap dimensions of the line. 

o These cells and linestyles will not change size when the ORD Annotation Scale is changed. 

Whether an individual cell or line style can be scaled is defined within the cell or linestyle definition. 

The Annotation Scale parameter is available on the Survey WorkFlow by selecting the Drawing tab. 

 

Changing the Annotation Scale value in the Field Book (FB) design file does 

not affect the way the file appears to other users who may be referencing the 

file. 
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Design File Settings 

The design file itself also has several settings used by the OpenRoads Designer survey software. To access 

these settings, select File > Settings > File > Design File Settings and then click the Civil Formatting item 

from the list on the left of the dialog. 

 
These settings are initially defined in the OHDOT Seed files and have been configured appropriately for 

ODOT projects. However, you may wish to change the following settings on a file-by-file basis. 

Coordinate Settings 
• The Format can be set to X,Y, or N,E as desired. 

 
• The Precision setting is used to control the display and precision of coordinates within the 

various civil and survey dialogs. 
 

Station Settings 
Controls the format, delimiter and precision of the station values to be used and displayed in the 
various civil dialogs. In addition, there are two options to control how equations are represented 
within the station values. 

 
• By Name - This is the standard legacy InRoads presentation (A100+00, B105+00, etc.) 

 
• By Index - This is the standard legacy GEOPAK presentation (100+00 R 1, 105+00 R 2, etc.). 

The OHDOT Seed files are defined to use this setting. 
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User Preferences 

The ORD User Preferences include several options for the civil products. These parameters are accessed by 
selecting File > Settings > User > Preferences as shown below. These options have been configured as 
necessary in the OHDOT workspace. See the Bentley online help for more information. 
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OpenRoads Standards > Survey Settings 

The Explorer dialog’s OpenRoads Standards tab contains an item for the Survey Settings. The Survey 

Settings defines the default project settings for the Survey software. Once a dataset has been processed, 

these settings are copied to the active design file where they can be edited by the user. 

 

Standards are read from the various Libraries. After you 

have processed survey data, the relevant standards are 

copied to the active file, which is listed in the Explorer 

dialog’s OpenRoads Standards tab as shown at left. 

To review the default settings, select the OHDOT item 

in the Survey Settings category as show below. The 

various parameters of the Survey Settings are 

displayed in the Properties dialog. 
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These settings are set appropriately for ODOT projects; however, there are occasions where you may wish 

to change some of the parameters on a per-project basis. The settings cannot be edited from the Library 

and must be edited from the copy contained in the active file. If you have not processed any survey data, 

you can copy the Survey Settings from the Libraries to the active file as follows: 
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• Browse to the OHDOT settings as shown at left 

 

• Right-click on the OHDOT Settings and choose the 

Copy option 

 

• Browse to the Survey Settings in the active file 

 

• Right-Click the Survey Settings and choose the Paste 

option as shown below 

 

 

Items that you may occasionally need to edit are documented on the following pages. See the online help 

for information not presented here. 
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General Settings 
 

 

 

 

 

 

 

Create Log File 
A log file of activity can be optionally saved to track changes to the Survey information. In the General 

Settings tab, set the Create Log File option to True as shown below. 

The log file is placed in the same folder as the DGN file. 

The log file is named with a .log extension using the name of the design file model. 

The log file contains the name of the user, the date and time, and a description of the action performed. An 

example of a portion of the log file is shown below: 

ethomas Thursday, January 31, 2019 12:25:05 PM Field Book MRW-314-8.08 Topo Name: from: Field Book 1 to: MRW-314-8.08 Topo 

ethomas Thursday, January 31, 2019 12:25:43 PM Load Data C:\Bentley\CONNECT\WorkSpaces\OHDOT\WorkSets\96213_D06_Survey\300-
Survey\SurveyData\FieldData\RawData\0800\MRW-314-8.08.csv 

ethomas Thursday, January 31, 2019 12:28:22 PM New Field Book Field Book 1 

ethomas Thursday, January 31, 2019 12:28:37 PM Field Book MRW-314-8.08 Scan Name: from: Field Book 1 to: MRW-314-8.08 Scan 
ethomas Thursday, January 31, 2019 12:28:48 PM Load Data C:\Bentley\CONNECT\WorkSpaces\OHDOT\WorkSets\96213_D06_Survey\300-

Survey\SurveyData\FieldData\RawData\0800\MRW-314-8.08SCAN.csv 

ethomas Thursday, January 31, 2019 12:29:55 PM Delete Field Book MRW-314-8.08 Scan 
ethomas Thursday, January 31, 2019 12:30:13 PM Field Book MRW-314-8.08 Name: from: MRW-314-8.08 Topo to: MRW-314-8.08 

ethomas Thursday, January 31, 2019 12:30:27 PM Load Data C:\Bentley\CONNECT\WorkSpaces\OHDOT\WorkSets\96213_D06_Survey\300-

Survey\SurveyData\FieldData\RawData\0800\MRW-314-8.08SCAN.csv 
ethomas Thursday, January 31, 2019 12:31:10 PM New Surface MRW-314-8.08 

 

Use VBA Macros 
ODOT uses the Visual Basic application OHDOT_Survey.mvba to draw additional annotations in the design 
file. These annotations are drawn when the survey data is processed. The application is also used to place 
annotations for drainage items as detailed in Section 400 of the ODOT Survey training material.   
 
The Use VBA Macros parameter is set to a value of True in the OHDOT Standards. The VBA Feature Macros 
parameter defines the macro that is applied for field codes for point and linear features. With the December 
2020 update to the OHDOT CADD Standards, macros have been added to annotate points similar to 
GEOPAK Survey. An example of the annotation placed by the VBA Macro for a point is shown below. 

 
Unlike the Survey Decorator annotations, which are not written to the file, 
these annotations are placed as text elements in file on the levels detailed 
below.  
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Annotation MicroStation Level 
Point Name SV_X_Text_Name 
Point Elevation SV_X_Text_Elevation 
Field Code SV_X_Text_Comment 

 
The display size of the annotations is set by use of the Annotation Scale parameter. 
 
Note: Survey Attribute data is not annotated using the VBA Macros. The OpenRoads Survey commands 
Element Annotation and Model Annotation are used to annotate attribute information.  
 

Linking Codes 

 

As previously stated, the Link Code Position parameter has been set to After Point Feature Definition 

with the OHDOT Standards. When processing older datasets containing the linking code before the feature 

name, the survey preferences must be copied into the active file and the value of the Link Code Position 

parameter changed to Before Point Feature Definition before processing the data. 

 

Data File Parsing 
 

The Description Separator has been set to the 

backslash character in the OHDOT standards and 

can be changed from the Data File Parsing tab as 

shown above. 

 

 

Descriptions can be added by use of entering a backslash character after the Field Code name as the data is 

collected in the field. An example of one of the CMON points in the CSV file is shown below: 

CMON\REF-108+50 

The description is written to the point attributes and can be displayed in the design file using the Survey 

Decorations as shown below. 
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Adjustment Defaults 
Various adjustments and blunder detection may be applied to survey raw data. The adjustments and 

adjustment settings apply to the entire field book. 

Most of these settings are device-dependent. For example, the Add-on for Distance constant value is 

dependent on the device used to measure distances. 

The Adjustment Defaults defined in the OHDOT workspace have not been changed from the Bentley default 

values. 

 

Terrain Model 
 

The initial settings for terrain models are defined in 

the OHDOT workspace as shown above. These 

values can be changed before processing survey 

data or after the fact by editing the terrain model 

properties. 
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Exercise 1: Importing Survey Data from a CSV file 

In this exercise we import field survey data from a CSV file. The sample project is in Morrow County. 

The process to import the ground survey data is summarized below: 

1. Create a 3D Field Book (FB) design file to import the survey information 

2. Create a new Field book 

3. Import survey data files 

4. Review and edit survey information as necessary 

Creating the Field Book (FB) design file 
ODOT projects that have been created outside of the ProjectWise environment using the OHDOT template 

contain the file 400-Engineering\Startup.dgn. This file is used as the launching point for opening ORD to 

create new DGN files for the WorkSet. The Startup.dgn file can be ignored once the initial design files for the 

project are created. 

Inside the ProjectWise environment, the Startup DGN file is not used. One of the seed files is used as the 

initial launching point to create new design files for the WorkSet. 

Take the following steps to open 96213_DesignSeed2d.dgn and create a new FB design file for the project. 

• Open ProjectWise Explorer 

 
 

• Browse to the folder shown below, using your home District and your use name. 
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• Right-Click on the file 96213_DesignSeed2d.dgn and choose the Open With… option to open the 

file with OpenRoads Designer CONNECT Edition. Toggle the Always use the program option ON 

 
• Select OK to open the file. 
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• Select the Ohio DOT WorkFlow from the top left of the ORD interface. 

 

• From the Apps tab, select the OHDOT Create Design Files icon 

 
The application is opened as shown below 

 

• Create the following DGN file: 

o Survey Field Book (FB) 

 

Which Seed File is used to create the FB design file? ____________________________________ 

 

Which folder is the file crated in? ___________________________________________________ 

 

• After creating the Field Book (FB) design file, close the DGN file  

 

• Open the newly created FB design file with OpenRoads Designer. 

 

  



 
Ohio Department of Transportation 
Office of CADD and Mapping Services 

January 2021 

 

OpenRoads Survey: Data Processing 300-17 

 

Importing a CSV file 
Importing topo survey data can be accomplished using the Explorer dialog, or by selecting commands from 

the ribbon menu. 

In this example, we will import the survey data using the commands from the Explorer dialog. 

 

• After opening the FB design file, select the Survey WorkFlow from the upper left pull-down menu. 

 
• From the Explorer dialog, open the Survey group 

 

If the Explorer dialog is not displayed, open it by selecting Explorer on the Home tab of the Survey 

WorkFlow 

 

• Right-click on the Field Books option in the Explorer dialog’s Survey group to create a new Field 

Book as shown below.  

 

The field book is created with the default name “Field Book 1”. The name can be changed by 

selecting the field book in the Explorer dialog and entering the new name in the Properties dialog. 
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• Import the topo survey information by right-clicking on the field book name in the Explorer dialog 

and choosing Import > File using Text Import Wizard 

 

o Browse to the following folder to select the CSV file containing the topo survey data 

300-Survey\SurveyData\FieldData\RawData\ 

 

o Select the file MRW-314-2057-TOPO-Scaled.csv 

 

o Choose the Add button to add the file to the Selected Documents list 
 

o Select the OK button 
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• After selecting the OK button, the Data Format dialog is opened as shown below. 

 
These files are preconfigured Text Import Wizard files that are configured for comma separated 

values (CSV) files in the following format: 

 

Column 1 Format  = Point Name 

Column 2 Format  = Northing 

Column 3 Format  = Easting 

Column 4 Format  = Elevation 

Column 5 Format  = Code 
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Column 6 Format  = Attribute Name 

Column 7 Format  = Attribute Value 

Column 8 Format  = Attribute Name 

Column 9 Format  = Attribute Value 

Column 10 Format  = Attribute Name 

Column 11 Format  = Attribute Value 

Column 12 Format  = Attribute Name 

Column 13 Format  = Attribute Value 

Column 14 Format  = Attribute Name 

Column 15 Format  = Attribute Value 

Column 16 Format  = Attribute Name 

Column 17 Format  = Attribute Value 

The OHDOT PT,N,E,Z,Code option is used to import survey data without any coordinate 

transformations applied as part of the import process. 

The OHDOT OH83/2011-NF PT,N,E,Z,Code and OHDOT OH83/2011-SF PT,N,E,Z,Code options 

contain additional parameters for the Projection Input and Projection Output, but only the 

Projection Input value is defined. 

Projection Input                 = OH83/2011-NF 
Projection Output 

 
The options are used to import data that is in State Plane coordinates. Since there is not a Projection 
Output value defined, the data is transformed to the active Geographic Coordinate System (GCS) 
defined in the design file. If the GCS is undefined, no transformation is applied. 

 
In most cases, coordinate transformations will be applied using the survey software before the CSV 
file is generated. Typically the CSV file will be processed using the OHDOT PT,N,E,Z,Code option. 
 

• Select the OHDOT PT,N,E,Z,Code format from the list. Select Apply to initiate the process. The CSV 

file is imported like the example below 
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Reviewing and Editing Survey Data 

Reviewing and Editing Points 
To review a single survey point, simply float the cursor over the point. A pop-up menu with information 

about the point will appear like the example below. 

 

The Element Selection command can be used to review or edit various properties of a selected point. 

When a point is selected, a menu of commands will appear onscreen as shown below. 

 

The following commands are available: 

• Properties 

• New Point Feature 

• Turn on/off All Annotations 

• Report 

• Create Control Point 

• Edit Observations 

• Delete 
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Point Properties 
Select Properties to access the menu shown below. 

 

This is the easiest way to edit the attributes of a point. 

Nearly every field in the dialog is editable. 

Note: The Scale fields represent the current MicroStation 

Annotation Scale setting and should not be edited. 

The properties of the selected element can also be edited 

in the Explorer dialog. 

 

 

 

 

 

 

 

 

Moving Points 
Occasionally it may be necessary to graphically move a point to a new location. When a survey point is 

selected using the Element Selection tool, the origin of the point is highlighted with a circle as shown in 

the example below. 

 

Using the Element Selection tool, the circle can be selected to move the point. 

To move a point to known coordinates, edit the coordinate values in the Point Properties dialog shown 

above. 

Caution: Depending on the value of the Terrain Model Attribute parameter, moving a point will also edit 

the associated terrain model. 
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Survey Details 
The Survey Details dialog is used to review and edit survey information. The dialog is opened by selecting 

the Survey Details icon from the Survey WorkFlow Field Book tab as shown below. 

 

The content of the dialog is determined by the selected item in the Explorer dialog’s Survey tab. In the 

example below, the Survey points that have the CMON feature definition assigned are displayed. 

 

Many of the fields in the Survey Details dialog can be edited by selecting the field, and then by clicking in 

the selected field. An example editing the Name field is shown below. 
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Individual points or a group of selected points can be edited in the Survey Details dialog by right-clicking 

on the area to the left of the selected point(s). The editing options shown below are available. 

 

 

Changes made to the data are dynamic and are applied instantly. For example, if a point is deleted the 
graphics are removed from the file, the terrain model is updated (if applicable) and any linear leatures that 

contain the point are updated. 

If you make an edit that you did not intend to make, simply select the Undo command. The last action is 

reverted. 
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Reviewing and Editing Linear Features 

There are three types of linear feature definitions in OpenRoads Survey: 

Dynamic Linear Features 

• Dynamic linear features are composed of points of the same feature 

• The chains are generated dynamically using the feature name and the linking codes 

• These chains will dynamically update on the fly if changes are made to the linking codes or to the 

feature associated with a point(s) in the field book 

• The order of the point list cannot be changed; points are connected in the order that they were 

numbered in the field 

Point List Linear Features 

• Point list linear features are comprised of a list of survey points 

• The order of the points is used to determine the linear feature geometry 

• Linking codes are also used to define the shape of the linear feature 

• Points can be included in the chain list in any order 

• The points that make up a point list linear feature can have different feature codes 

• These linear features are just like survey chains in GEOPAK Survey 

Graphic Linear Features 

• Graphic linear features are drawn one at a time as a MicroStation graphic, ether by converting a 

point list linear feature to a graphic linear feature or by importing a 3D MicroStation graphic line 

• If you convert a point list linear feature to a graphic linear feature any subsequent edits to the 

points that originally defined the chain will not update the graphic linear feature. This allows users 

to make edits to the graphic chain using MicroStation commands. 

• Graphic linear features can be include in the terrain model 

These linear feature types are hierarchical. A Dynamic Linear Feature can be converted to a Point List. A 

Point List type can be converted to a Graphic type. 

The OHDOT Survey Settings have been configured to generate Point List Linear Features as the default. 

To review a single linear feature, simply float the cursor over the element to reveal a pop-up menu like the 

example below. 
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The Element Selection command can be used to review or edit various properties of a selected linear 

feature. 

When a Point List Linear Feature is selected, a menu of commands as shown below will appear onscreen. 

  

The following commands are available if the selected linear feature is a Point List Linear Feature: 

• Properties 

• Append Point in Linear Feature 

• Remove Point from Linear Feature 

• Join Linear Features 

• Move Point Along Linear Feature 

• Insert Point in Linear Feature 

• Close Linear Feature 

• Break Linear Feature 

• Transpose Linear Feature 

• Move Linear Feature 

• Report 

• Convert to Graphic Linear Feature 

• Manage Point List 

• Edit Point Features 

• Delete 

See the online documentation for information on each command. 
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Select the Properties item to access the dialog show below. The properties of a point list linear feature are 

shown below. 

 

Many of the fields in the Properties dialog can be edited 

directly in this dialog. 

Linear features can also be edited using the Survey 

Details dialog as described above for points.  
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Exercise 2: Survey Annotation Example 

In this exercise we will process a CSV file that contains point and linear features for every ODOT field code. 

This dataset is used for testing and review of the ODOT code list and OpenRoads Feature Definitions for 

Survey. The dataset is a good example for how each of the survey codes will be annotated using the 

attribute data that can be entered for each point. 

• Open ProjectWise Explorer 

 
 

• Open the 96213_FB001.dgn file using your home District and your user name (use D06 for Central 

Office employees).  

 
• Select the Ohio DOT WorkFlow from the top left of the ORD interface. 

 

• From the Apps tab, select the OHDOT Create Design Files icon 

 

• Create another Field Book (FB) design file for this exercise 

 

• Open the newly created Field Book (FB) design file 

 

• Create a new Field Book to import the data. 

 

• Import the following CSV file: 

 

300-Survey\SurveyData\FieldData\RawData\AllSurveyFeatures.csv 
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Survey Decorations 
Survey decorations are temporary annotations displayed in the design file containing the field book. These 

annotations replace many of the annotations that were placed in the design file with the legacy GEOPAK 

Survey software. 

Survey decorators are toggled on/off on demand. These on/off commands are found by selecting the 

Survey workflow Analyze tab as shown below. 

 

In the example below, the Name, Field Codes, and Elevations decorations are toggled on. 

 

The display parameters for Survey Decorations are defined by the User Preferences. Select File > Settings 

> User > Preferences to access the View Options – Civil parameters as shown below. 
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Note that Survey Decorators can only be displayed in the design file that contains the field book. The 

decorations cannot be displayed from a reference file attachment. 
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Survey Annotation 
Survey elements can be annotated individually, by a selection set, or by an entire Model. 

• In the Survey WorkFlow, select the Drawing Production tab 

 

• From the Drawing Production tab, select Element Annotation. 

 
The Element Annotation command is used to annotate individual or multiple elements. When the 

command is selected, you are prompted to select the survey element(s) that you wish to annotate 

as shown below. 

 
• Choose the element(s) you wish to annotate. Reset when complete. The selected elements are 

annotated based on the Feature Definition of the element. 

 

• Adjust the Annotation Scale value (Survey > Drawing > Drawing Scales > Annotation Scale) as 

desired to view the annotations. 

In the example below, three elements were selected to be annotated. 

 

Some of the feature definitions are defined to place text on a level that the designer may elect to use 
in the plan sheets. In the example above, the annotation for the stump and the trees was placed on 

the level VG_X_Text. 

Other annotations are placed in the file for information, but not intended to be shown on the plans. 

This text is placed on the level SV_X_Text with a transparency value of 70. 
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The example below shows the annotation for a building feature (Field Code BLD). The points are 

annotated with the attributes that were assigned to each point. In this example, the attributes were 

entered for only the first point of the building as shown below. 

 

If the building is annotated, using the Annotate Element command, the text is constructed from the 

attribute data and placed on the level BD_X_Text like the example below. 

 

• Choose the Annotate Model command to annotate all the survey elements in the current model. 

The example below shows the annotations that are placed for both the building and the points that 

were surveyed for the building.  

 

The point annotation is not intended to be shown on the 

plan and is placed on the SV_X_Text level. 

Note: In this example the attributes were entered for only 

the first point on the building. 
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Notes: 

Every survey element is not annotated. Some of the ODOT Feature Definitions are not configured to 

place annotation in the file.  

Annotations are dynamically updated. If you edit a survey point to change the attribute information, 

previously placed annotations are updated accordingly. 

Annotations can be moved and edited as need, however, if you reannotate an element or a model 

the annotations are returned to their default location and value. 

Annotations are placed using the current Annotation Scale value and will be resized if the 

annotation scale value is changed. 
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Exercise 3: ODOT Monument Report 

The ODOT Monument Report application is used to assist the surveyor with the task of filling out the 

monuments sheet of the required Survey Master excel file. The application is accessed from the Ohio DOT 

WorkFlow as shown below. 

Take the following steps to generate the monument report for the project: 
 

• Open ProjectWise Explorer 

 
 

• Open the 96213_FB001.dgn file using your home District and your user name (use D06 for Central 

Office employees).  

 
• Select the Ohio DOT WorkFlow from the top left of the ORD interface 

 

• Choose the OHDOT Monument Report icon to open the Monument Report Generator dialog as 

shown below. 
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• Select the Survey Maser file. The file is located in the following folder: 
 
..\300-Survey\SurveyData\Reports\96213_SurveyMaster.xlsx 
 

Monuments points found in the current design file are listed to the left under the Survey Point heading. 
 
OpenRoads alignments, located in reference attachments, are listed under the Alignments heading. 

 

• Select the Survey Points that you wish to add to the selected Alignment. If there are not any 

alignments found, select the No Alignment option. The selected alignment is used to compute the 

station and offset for each point placed under the alignment. 
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After adding the selected Survey Points to the Alignments list, the Place in Survey Master icon is 

enabled. 

• Select Place in Survey Master to add the selected points to the Survey Master Excel file. The 

selected points can be either append or replace data in the selected Survey Master file by choosing 

the appropriate option before placing the data in the survey master file. 

The selected Survey Master Excel file is opened like the example below. Select the MON TABLE tab to 

review the imported information. 
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• After reviewing the survey master information, exit Excel. When prompted, select the Check In 

option to check the excel file back into ProjectWise. 

 

• Exit OpenRoads Designer. This completes Exercise 3. 
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Media Files 

The photos from data collectors with a camera can be attached as a photo attribute to a survey point. With 

the ODOT configuration, Trimble data collectors will prompt the surveyor to take a photo. If the data 

collector does not prompt for a photo, after taking a photo with the data collector the photo can be assigned 

to a specific point. 

The example below shows a portion of a .csv file with photo attributes defined. 

 

ORD version 10.09.00.91 adds the configuration variable CIVIL_SURVEY_PHOTOS_FOLDER that is used to 

define the location of the photo files. This variable is defined in the WorkSet configuration file as follows: 

CIVIL_SURVEY_PHOTOS_FOLDER = $(_USTN_WORKSETROOT)300-Survey/SurveyData/Images/Field/ 

Note: Media files cannot be viewed across reference file attachments. You must be in the design file 

containing the Survey Field Book to view media files. 

The Icons decorator may be used to display an icon for points that have a photo attached. 
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When the Icons decorator is toggled on, a circle is displayed over the points that have a photo attributes 
defined as shown below. 

 
Reviewing the point properties will list the name of the attached Media File as shown above. 

To view the associated media file, select the element using the Element Selection tool. Allow the mouse to 

hover over the selected point until the pop-up menu is displayed as shown below. Choose the Media 

command. 

 

The associated media file is displayed. 

The command can also be selected from the ribbon as shown below. 

 



 
Ohio Department of Transportation 
Office of CADD and Mapping Services 

January 2021 

 

OpenRoads Survey: Data Processing 300-41 

 

The media is displayed in the file like the example below. 

 

The media window contains tools to mark up and edit the photo.  
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OpenRoads Software Version 

This document was prepared using the following software version: 

OpenRoads Designer CONNECT Edition – 2020 Release 2 Update 8 – Version 10.08.00.88 

 

Contacts 

For any questions, suggestions, or problems with this document please contact the ODOT Office of CADD 

and Mapping Services by use of the following form on the ODOT website: 

https://odot.formstack.com/forms/cadd_servicerequest 

 

 

https://odot.formstack.com/forms/cadd_servicerequest

